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PDMS simplified pipe guide v.3

• …0_0
• simplified.. 

Sida 1
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• You should read the equipment guide also..

Repetition
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• Each elements position and orientation 
depends on the hierarchical structure

• An element’s position and orientation is 
relative to its owner

Repetition: Viktigt
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A
Owns

OwnsB

C

A

B

C

Move

A

B

C

Move

B owns  C and C keep its position relativly B

A is rotated and both B and C rotates along

Repetition: Exempel hierarki
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• At the top of the hierarchy is WORLD, also known as /*

• WORLD owns everything

Repetition: WORLD
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• You can give elements a name

• Names must be unique

• Names begin with a / example:  /TANK-1

• Is it common to only name special elements, such as nozzles to have their 
name on drawings. 

• Name give to a nozzle is usually in the form of /”Equipment name”/”Nozzle 
name” to ensure that the nozzle name is unique

Repetition: Name

Henrik Landström | henrik@landstroms.se
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• CE is short for Current Element, and it the element currently selected. 

• Everything in PDMS can be done in 42 different ways, 4 of them are really great, 10 good and the 
rest not so good..

• Don’t use the X in top right corner to close forms, use [Dismiss] or [Cancel] buttons

• In “ordinary” CAD you use X, Y and Z. I PDMS (and most other piping software) we have EAST, 
NORTH, UP aka E,N,U. Negative directions are WEST,SOUTH, DOWN or W,S,D.

• It doesn’t matter which of the directions you use, you can even mix them, ex. X,N,U or WEST 40, -
Y 500, Z -500. 

• Memory rule: NEW YORK.

• NORTH = Y 

• This guide uses x, y and z

• Undo works when using new methods, not old..

Repetition: Tips

Henrik Landström | henrik@landstroms.se



8

Modify Orientation

Save
Add to Drawlist

Remove from Drawlist

Navigation Level.

How deep in 
hierarchy you want 
to select elements

GMM

Meassure

Show axis on CE

Navigate between 
past CE

Explicit Position

Create/Modify

List Pick active list

Delete CE

Common buttons on main ribbon

Henrik Landström | henrik@landstroms.se

Navigate to Element
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Explanation of layout and words used

Orientate > Rotate Underlined text refers to navigation through 
menus, on forms or by right clicking with the mouse.

Form, window, dialog box refers to said features. Marked with a 
blue frame.

Textbox refers to row where you can type in text, when you start 
typing the box will change colour.

Aid graphics, axes and other visual elements refers to elements 
that are drawn on screen to. Marked with green.

Checkbox refers to..checkboxes. On/Off option only.

Dropdown list, several options.

”wrt” refers to the element name in the textbox to the right of the 
“wrt” text. The abbreviation means ‘with respect to’.

[Enter] Text between [ ] refers to buttons. Implied that you should 
press it.

This box is for text commands in the Command Line that 
have same effect as menu clicking ex, > rot by 45 about z

Henrik Landström | henrik@landstroms.se
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Navigation Level

Henrik Landström | henrik@landstroms.se

Navigation Level : Equipment is active in the 
dropdown list. Even though CE is the  
cylinder, the whole pump is select (enclosed 
by aid graphics green box.

Short explenation fo navigation level

Navigation Level: Element selected, now 
only the cylinder is enclosed by the aid 
graphics.
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What we build

Henrik Landström | henrik@landstroms.se
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• The Pipe element owns  Branch elements.
• Pipe element does not have a position or orientation.
• It is the Branch element that owns all piping components.
• Branch elements does not have a position or orientation

Introduktion: Pipe hierarchy

Henrik Landström | henrik@landstroms.se

Pipe

Branch

Components
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• The Branch has a Head and a Tail, which corresponds to the beginning and 
end of the Branch and also flow direction

• Flow is from Head to Tail

Introduktion : Branch

Henrik Landström | henrik@landstroms.se

Head

Tail
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Repetition: Branch cont.

Henrik Landström | henrik@landstroms.se

Schematic Pipe element that owns 5 Branch element (coloured lines) with flow 
direction in arrow direction. Therefor, location of arrow = Tail of Branch
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Introduktion : Components

Henrik Landström | henrik@landstroms.se

• Components are items such as elbows, tees and 
• Components have (most of the time) an Arrive and a Leave port. Arrive 

where flow enters component and Leave where flow…yes…leaves...

Leave

Arrive
Arrive Leave
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Introduktion : Pipe
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Pipes, or tubes in PDMS are implied items. As a user you don’t not create 
them, rather PDMS will automatically create tubes when certain 
conditions are met between components.

1) Arrive and leave are lined up
2) Size (Bore) matches

If these options are true, PDMS will create a tube

Tube
Arrive and Leave 

not allinged

Bore doesn’t match

All true – we get a pipe
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We are going to use the sample project supplied with PDMS to 
get some equipment to connect our pipes to and to get some 
other stuff that we will try and to no clash with.

Start PDMS

Select the following

Project SAMPLE 

MDB SAMPLE 

Module DESIGN 

User ADMIN 

[OK]

Nu åker vi!

Henrik Landström | henrik@landstroms.se
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This is how it looks for me..not much fun.

Now lets add some stuff to our Draw List so we 
can get a visual

Expand the Site named STABILIZER and select 
the Zone named EQUIP and add it to the Drawlist

Nu åker vi!

Henrik Landström | henrik@landstroms.se
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We need to do a change to the equipment before 
we can use them, because most of the nozzles 
are already connected to sample piping and we 
want to remove that connection.

The actions taken here will not be explained in 
detail.

[Create\Modify List]

Add>List… enter NozzCref as name

Add>Selection..

Fill the form the same way as the image

[Apply]

Prework, removing connections..

Henrik Landström | henrik@landstroms.se
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Now we have a list of all nozzles.

Type in 

Cref nulref 

in the textbox and [Action]

Now we have removed all connection from 
nozzles to pipes…

Cref = Connection Reference and we just 
changed it to nul…

Back on track!

Nu åker vi!

Henrik Landström | henrik@landstroms.se
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Zoom in and rotate to get a good view on the pumps P105A and P150B

New Branch

Henrik Landström | henrik@landstroms.se
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Enter the Pipework module 

Design > Pipework

The first thing that happens is the Default Specifications dialog 
box jumping out. Here you can select the default piping 
specification, as well as insulation and tracing.

You can and will change the specification later and other 
options later at any stage.

So lets accept the defaults and press [OK] to move forward.

If the option Pipework is grayed out and unselectable it means 
you are already within Pipework.

Pipework

Henrik Landström | henrik@landstroms.se
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There are two major methods in PDMS regarding how you create your 
piping, the old and the new.

Old method uses a couple of floating dialog boxes and new method uses 
more stylish docked dialogs.

In this guide we are going to use to new method.

If you wan to try the old, you can reach the dialogs from Create > Pipe, 
Create > Branch and Create > Components. 

Now, lets create a Zone to own or pipes
Create>Zone

“NEWPIPES” as name.

Select the zone /NEWPIPES (it is now our CE)

How to create pipes?

Henrik Landström | henrik@landstroms.se

Old

New
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If you do not have the Pipework tool ribbon, right click on an empty space next to another ribbon and select 
Pipework.

The different buttons are:

[1] Change specification, current specification is written to the right, this case: A150

[2] Create new Pipe [3] Modify existing pipe

[4] Create new Component [5] Modify existing Component

[6] Delete Component [7] Align Components

[8] Modify orientation of Component

Press on button [2], Create new Pipe

New method: Pipework toolbar

Henrik Landström | henrik@landstroms.se
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Ok, now we got the Create Pipe form up and docked to our right. We can 
now give our new Pipe a name, select a Specification and couple of other 
data attributes

Lets pick the name ”P-A1A-N1 and select he specification A1A

We are not entering any information regarding size at this stage, because 
that information will come automatically when selecting nozzles during 
Branch creation

[Apply]

New Pipe

Henrik Landström | henrik@landstroms.se
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Now a Pipe is created in the heirarchy owned by NEWPIPES (if some 
other zone had been CE, the Pipe had ended up owned by that Zone).
The Create Pipe form changes apperance and we can now create and 
connected Branches.

1) Current Branches owned by the Pipe. Right now the one we are 
creating.

2) Create new Branch

3) Change specification and name of the Branch

4) Change Head attributes

5) Connected Head

6) Change Tail attributes

7) Connected Tail

Press [Change] for Head Connection, 5)

New Branch

Henrik Landström | henrik@landstroms.se
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Now the form changes appearance again….a couple of buttons are the 
same as before, but on the bottom part of the form is new button

1) Pick element to connect Head to

Choose [Pick] and click the N1 nozzle of P105B
Now Name will change to the name of the Nozzle, P150B-N, we also 
get Bore and Connection information

There’s also aid graphic arrow showing in the 3D-view with information 
regarding P-Point number

Finish with [Connect]

New Branch, Head

Henrik Landström | henrik@landstroms.se

1
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Now choose [Change] for Tail Connection and [Pick] the top nozzle on P150A.

The Create Pipe form now magically changes name to Modify Pipe and the 
image to left should resemble what you have on screen.

In the 3D-view there’s a dashed line between Head and Tail , so you get a visual 
on what you have connected the Branch to.

New Branch, Tail

Henrik Landström | henrik@landstroms.se
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Create Components

Henrik Landström | henrik@landstroms.se

Now we got a Pipe, which owns a Branch and the Branch has its Head and 
Tail connected to nozzles. 

Lets create a component

Press [4] to bring up the Component Creation Form

4

1

2

3

1) Select another Branch where you want to place Components into.

2) Select another specification for the Branch.

3) List of  Components in the specification you can build.

Select Gasket
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1) Back and choose another Component
2) List of different types of selected Component
3) The component the new component will Connect to 

(we have no Components now, but let’s keep an eye 
on that line after we add the gasket)

4) Change build direction. If it’s Against Flow, switch to 
With Flow

5) Places and connects new Components to 
Components listed at 3)

6) Place new Component on the Branch
7) Deselect if Component should be places after CE or 

after Component listed at 3)

Select the #300 Gasket and [Connect] 

Now 3) ”Creation from…” will change to Gasket 1.  There’s 
also aid text at the nozzle stating we have a gasket, 
thou it’s invisible

Click 1)  [Choose]

Create Components, cont.

Henrik Landström | henrik@landstroms.se

2

1

5

3

6

7

4



31

Now pick Flange.

Select the flange with Stype WNA

[Connect]

Now we have a Flange in place after the Gasket

Notice of the ”Creation from..” text now prints FLANGE and the same with 
aid graphics.

Create Component, Flange

Henrik Landström | henrik@landstroms.se

1) We created our Gasket first and then Flange. If you 
have 1) checked you can skip the Gakset and create 
the Flange first, and PDMS will place a Gasket by 
itself… 

1
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Ok, back to list of Components and this time we pick an Elbow.

Select the Eblow at the top of the list and [Connect]

Current results in 3D-view and Design Explorer should look like images to 
the left.

Notice that the dashed line that earlier connected Head and Tail now 
connects Leave of Elbow and Tail

Create another Elbow

New Component, Elbow

Henrik Landström | henrik@landstroms.se
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You can move Componets with three different methods, >Command Line, dialog 
boxes or the Model Editor (GMM)

We will start with the Model Editor, and stick with it for most of the tutorial.

So turn it on by clicking its icon in the toolbar and close the Create Component 
Form.

Move Component, 1

Henrik Landström | henrik@landstroms.se

When you turn it on, a purple axis-ish looking 
feature will appear at the center of your CE. 

Lets just call it ME, short for Model Editor..

With the ME, you can drag in the purple lines or 
arcs for interactive moment of component or right 
click them for more options.

We start of easy by pulling in the X-axis line by 
clicking and holding the left mouse button

.. 

You get direct feedback on how far 
you have moved the Elbow

Model Editor Off

Model Editor On

Release the mouse and PDMS 
creates the tube
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Move Component, 1 cont.

Henrik Landström | henrik@landstroms.se

Now drag the Y axis to miss align the current Elbow from the 
previous Elbow and notice how the tube disappears.

Now the dashed Branch line is draw from first Leave of first 
Elbow to Arrive of the last, and then onwards to Branch Tail.

Undo works when using the ME, so lets undo this move.

Go crazy and create a whole lot of Elbows and move them all 
around while exploring different ways on how to use the ME.

You can rotate the Elbows by pulling the arcs between the 
axes, but only rotate in steps of 90 degrees.

When you create a new Elbow you need to click on it to have 
the ME change target.

Try different options when right clicking axes or arcs
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Clicking on a Elbow between two 
tubes and dragging it away from 
tubes will break the pipe.

Move Components

Henrik Landström | henrik@landstroms.se

Clicking on the Tube between 
two Elbows will make one Elbow 
CE (yellow) and mark the Tube 
and other Elbow with green 
outline.

Dragging with the ME now 
moves  all three Components

Pressing [CTRL] key and clicking 
let you select several Tubes

Clicking on a selected 
Component will deselect it.

You can also do an ordinary 
selection box (like AutoCAD or 
Explorer) that covers the 
Components you want to select 
them
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So far we have built in the flow direction of the Branch, from 
Head to Tail

Bring up the Component Creation Form and select Against Flow

Component flow

Henrik Landström | henrik@landstroms.se

Head

Tail

Select the last Elbow you have created, notice that the aid 
graphic and text is at the Elbows Arrive port now.

[Connect]

And now we new Elbow placed Against Flow..

..delete that Elbow.

ELBO 1

ELBO 2 ELBO 3
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Keep the Against Flow setting.

Select the Branch as CE

[Choose] and select  Flange as Component, and select SType
WNA #300 [Connect]

Notice that PDMS automatically created the Gasket

1) Also look at the Design Explorer’s list of Components in Flow 
Direction. The newly created Components are at the end of the 
list.

Component flow, Flange at Tail 

Henrik Landström | henrik@landstroms.se
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Delete the Pipe you have done so far and create a new Pipe, with 
the same name and specification

Build something that’s similar to image

Switch to Against Flow and create a new Elbow at the Tails 
Flange.

Select the Elbow with ME on, and right click on the X axis.
Then select Align with Feature…

Now PDMS will start tracking your mouse movements and 
displaying lots of aid lines to visualize what the Elbow will align 
with and how the alignment will work..

Select Through normal Ppoint Feature on the Elbow above the 
other pump (while trying out the different ME functions earlier 
you should have used this….)

Lets finish our first pipe

Henrik Landström | henrik@landstroms.se
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Place another Elbow and align it also.

Now we need to rotate our CE.

Right click on the lower half of the arc between the Y and Z axis 
and select Orient To Point…

Then select the other Elbow and we are done!

Lets finish our first pipe

Henrik Landström | henrik@landstroms.se
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We are not done! When you think you're done you need to run 
a check to know if the Pipe is health or if something is 
astray

Enter the menu with Utilites>Data Consistency.
Select the Branch or Pipe as CE and [Apply]

Or you can select the Branch and type in
>check ce

If everything is Ok you’ll get the following message
*--* NO DATA INCONSISTENCIES *--* 

If there are errors, you need to consult PDMS Design 
Reference Manual Part 4 or ask someone who might 
know…

Done…

Data Consistency Check

Henrik Landström | henrik@landstroms.se
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Create a new Pipe, call it P-A3B-N2 (or whatever you 
like…)

Connect the Branch Head to the vertical drum and 
the Tail to the pump as show.

Then create a Flange and Elbow, SType WN at both 
Head and Tail.

If you create your components and they don’t appear 
where you expected, double check your flow 
setting and what you had as CE before clicking 
[Connect]. 

Otherwise it can end up like this..with the second 
Flange inside the pump

..more piping, Align Selection/Component

Henrik Landström | henrik@landstroms.se
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Align Selection/Component

Henrik Landström | henrik@landstroms.se

Create an Elbow at the Flange under the drum.
Create an Elbow at the pump’s flange also (should have 

been a Reducer first but we’r skipping that now..)

Now set the Elbow at the drum as CE and press
[Align selection/component]

Automatically PDMS will move the CE and try to align 
Leave of CE and Arrive of the next component in 
flow.
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Select the Elbow at the pump and press 
[Align selection/component] again

…not that good..it Align with the other Elbow but broke the 
tube to the pump..

Undo to return to previous position.

Change the orientation of the first Elbow by a couple of 
degrees and [Align selection/component] again.

Now it’s a bit better, but not good enough. We need to 
rotate the first Elbow more. Rotate by the ME to align 
the Leave port with the W direction

[Align selection/component]  a last time to finish the pipe.

Align Selection/Component

Henrik Landström | henrik@landstroms.se
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Now lets create a Tee

Select Tee in the Component Creation form

1) Size of Connection

2) How our current Branch will flow through the Tee

Pick ”Conn. Bore” 100 and Stype TEE and set 2) to the middle 
option.

Take note on which component you have as CE and your build 
direction, With or Against Flow.

[Connect]

And we broke the pipe…why??

Zoom in on the Tee and take  a look, the Branch line is leaving 
from the branch of the Tee

Lets fix it!

A Tee

Henrik Landström | henrik@landstroms.se
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On the toolbar Modify > Component > Arrive/Leave to bring up the 
Mod Comp Arrive/Leave-fönstet

1) Select if you want to change port for Arrive or Leave

Pick Leave

2) Select which Ppoint the Leave port should be located at.

Pick P2

[Apply]

Move the Tee to the middle of the tube with the Command Line, 
select Tee as CE and type in 

> move dist 1900

Or just use the ME if you hate typing 

Tee, Leave andArrive

Henrik Landström | henrik@landstroms.se

1
2

> q arr 

> q lea

> arr 2
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New branch

Henrik Landström | henrik@landstroms.se

Bring up the Modify Pipe form and press [New 
Branch]

Connect the Head to the Tee and Tail to pump 
P1501A’s suction

Rotate the Tee so it doesn't point upwards and 
place a Flange at the pump and then complete 
the pipe by adding an Elbow
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Valve

Henrik Landström | henrik@landstroms.se

Create Components form and select Valve type

Select the Tee if you’r building with the flow, or the 
Elbow if you’r building against the flow.

Pick SType Gate and press [Connect]

Now PDMS informs us that we need to make a 
decision regarding Flange type.

If you zoom in on the Valve and pick between the 
STypes FSO, WN and ORI you can see PDMS 
updating  components and graphics on the fly

Try selecting the Valve with the ME and drag, and 
notice that PDMS also moves the flanges.
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Change Valve SType

Henrik Landström | henrik@landstroms.se

Ok, you’r happy with a Gate valve but somehow 
there’s a change and now it should be a Globe valve 
instead.

Bring up Component Selection Form, and select the 
Globe valve. 3D-view updates after selection, make 
the change by pressing [Reconnection]

There’s a dropdown list called Type, using this you 
can even change the valve into somthing else, like a 
restrainer…try it 
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New Branch on your own…

Henrik Landström | henrik@landstroms.se

Here’s a set of images, displaying what you should 
do, try to follow them.

Use these buttons 
to move Tee

Remember to 
change branch 
when creating  
second Tee

Only a new Branch

Delete Eblow
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Check CE

Henrik Landström | henrik@landstroms.se

Ok, lets check the topology

We’ll take one Branch at the time

Blueish: >check ce
TEE 1 =15392/10192

D400 ARRIVE TUBE LESS THAN TUBE 
MINIMUM ACTUAL TUBE LENGTH IS 32.83mm

Double click the row TEE 1 = in the Command 
Window, then erase the TEE 1 string and space 
before =, leaving you with =15392/10192 (you’ll have 
another number..)

Now that Tee with error is CE. Looking in the 
manuals, the error D400 is exactly as printed, we’r 
breaking a rule specifying minimum pipe length.

Good rule as you can’t weld like that, but this is for 
fun so let’s ignore it.
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Check CE

Henrik Landström | henrik@landstroms.se

Greenish: >check ce
Date 17 Apr 2012 Time 17:16
BRANCH /P-A3B-N2/B3

C540 THIS BRANCH HAS NO COMPONENTS 
END 
*--* NO DATA INCONSISTENCIES *--* 

Good, no inconsistencies, C540 is just a warning.
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Check CE

Henrik Landström | henrik@landstroms.se

Purpleish: >check ce
Date 17 Apr 2012 Time 17:17
BRANCH /P-A3B-N2/B2
GASKET 1 =15392/10187

D610 LEAVE CONNECTION TYPE NOT 
COMPATIBLE WITH CONNECTION

TYPE OF LSTUBE 
VALVE 1 =15392/10184

D400 ARRIVE TUBE LESS THAN TUBE 
MINIMUM ACTUAL TUBE LENGTH IS 25.4mm

D410 BAD ARRIVE GEOMETRY 
Tolerance Angle is     : 0.572958E-01 Actual 

angle is : 180.000
D430 BAD ARRIVE CONNECTION TYPE 
D610 LEAVE CONNECTION TYPE NOT 

COMPATIBLE WITH CONNECTION
TYPE OF LSTUBE 

GASKET 2 =15392/10185
D400 ARRIVE TUBE LESS THAN TUBE 

MINIMUM ACTUAL TUBE LENGTH IS 25.4mm
D410 BAD ARRIVE GEOMETRY 

Tolerance Angle is     : 0.572958E-01 Actual 
angle is : 180.000

D430 BAD ARRIVE CONNECTION TYPE 
END 

If you did not get this error – good for you 
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Check CE

Henrik Landström | henrik@landstroms.se

Zooming in we can easily view how the valves 
flanges crash with the connection flanges.

You can fix this in  a couple of ways.

Easy and straightforward is deleting the flanges and 
gaskets, and then creating new ones.

Another one is reconnecting the components, this 
can be done with the Command Line or a dialog box 
through Connect>Component

First, select gasket the Gasket above  the Valve in 
the Design Explorer. Now the Gasket should connect 
to the Valve which is Next in flow, to pick Connect to 
Next and [Apply]. Then select the Flange first in flow 
order, press [CE] to have the Connect Component 
form load it as CE and [Apply]

For the Gasket and Flange after the Valve you need 
to change the dropdown list to Connect to Previous 
and repeat.

All should be OK now.

Next

Previous
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Check CE, Command Line

Henrik Landström | henrik@landstroms.se

Instead of using the Connect Componet form you can 
as mentioned use the Command Line.

Follow the same pattern as with the form, but instead 
of using the dropdown list to change direction you 
type
> back or >forw
To connect you type
> Conn
And to check your current build direction you use
> q mode

But that was a lot of typing…to make it easier you 
can just type in
>conn to next
>conn to pre

And use
>next
>pre
To navigate between the components

Before using the Command Line to change 
direction and connect stuff, please take a look at 
the end of this document and read 
Forwards/Backwards VS With Flow/Against Flow

Next

Previous
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Lets change spec on a Nozzle.

Enter Equipment, Design>Equipment

Select Nozzle P1501B-N2

Modify>Nozzle Specification

PDMS might prompt an error message now (did for 
me, but just ignore it..)

Now lets pick a nozzle spec like the image and [Apply]

Change Nozzle specification

Henrik Landström | henrik@landstroms.se
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Create a new pipe with the A150 spec. Name it P-A150-
N3 

Connect the Head to P1501B-N2

Instead of connecting the Tail we’r going to place it by 
cordinates. 

[Change] for Tail Detail

Now we can set Bore at 100 (both Tail and Head need a 
Bore otherwise you can’t create Components)  and 
enter position. We could place this anywhere but let’s 
just leave it per default.

[Apply]

New Pipe

Henrik Landström | henrik@landstroms.se
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Place a Flange at the Nozzle and a Reducer up to 200, 
end with an Elbow

New Pipe, add components

Henrik Landström | henrik@landstroms.se
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When pushing components around you often have clearance rules 
governing your work. 400mm from this equipment, 200 from that and 
so on..

..luckily Move Clearance works exactly the same for piping 
components as it does for equipment primitives

Through the menu Position > Component > Clearance

[Apply] and select appropriate Ppoint on the equipment.

If you want to use the ME, the best way I have found is Aligning with 
the surface, then moving backwards 500 + outside diameter / 2

Get outside diameter by Query>Properties…

> move clear 500 infront idp@

Move Clearance

Henrik Landström | henrik@landstroms.se
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When measuring components and you want the distance to the 
surface and not centre you need to change settings from Any to 
Graphics in  1)

Then you can select the vertex on the edge of the Eblow .

2) Displays what you’r going to select

Move Clearance, measure

Henrik Landström | henrik@landstroms.se
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Create a new Elbow and drag it in front of the equipment 
Ventilation_Unit1

Rotate the Elbow upwards and create a second Elbow

Pipes and Components have two attributes known as BoP – Bottom 
of Pipe and ToP – Top of Pipe. 

Position > Component > BoP/ToP

[Apply]

> bop 500 onto idp@

Move Clearance, BoP/ToP

Henrik Landström | henrik@landstroms.se
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We still have the Branch line leaving the elbow and heading of in 
space.

We fix this by going into Connect>Branch

Change to Tai, and in the dropdown list to Last Member

[Apply]

Reason for this is if you have 10 users, everyone leaving Branch 
lines all over the place it can quickly get ugly…

Connect Branch
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Now we're going to build this pipe

First, enter the Equipment module and change Nozzle 
specifications to 150 Ansi and Bore of 50 for both Nozzles.

Then create a new Pipe and connect the Head and Tail.

Create Flanges and both Head and Tail and the two first Elbows 
at the Head, exact tube lengths are not important.

Angels and random moves

Henrik Landström | henrik@landstroms.se



63

Create another Elbow and use the Align selection\component 
button to move it to the intersection of the Tail.

Use the ME and select the Leave axis, right click and Orient To 
Point.

Select the Tail Nozzle.

Now the Elbows rotates to orient it’s leave without changing the 
X-Y plane.

Angels and random moves, cont.

Henrik Landström | henrik@landstroms.se



64

Use the Command Line to ask for the information regarding the 
Ppoint at the Leave port.

> q pl 

Ppoint 2 of ELBOW 3 of BRANCH /test/B1
Bore 50mm
Direction W 30 S
Position E 8619.589mm N 10731.922mm U 2816.2mm
Connect BWD

Double click the row Direction W 30 S and hit [Enter]

PDMS now changes the direction of the Elbow and in that 
process the angle is changed to match the Arrive port.

Now it’s easy to add the last Elbow
and move it up to complete
the pipe.

Angels and random moves, cont.
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The reason we went through the trouble with >q pl and changing 
direction is because we wanted to change one direction at the 
time.

If we wanted to do like in the left image, we would have created 
an Eblow at the Tail, and then used the following commands, 
starting with Tail Elbow as CE

> back
> conn to next
> forw
> pre (to select other Elbow, or just select it with the mouse)
> conn to next

Or if we had the pipe at same elevation as the Tail Flange we 
could have just used the Align and Orientate buttons…

Thinking of it – pulling the pipe of to the same elevation, fixing the 
Elbow angle and then pushing it back down is even easier than 
going throughtpast pages…

Angels and random moves, cont.
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Ok, that’s…I would have liked to add even more stuff (my first 
draft had more, but time is not abundant..)

Have fun and hope something was useful.. 

The end…

Henrik Landström | henrik@landstroms.se



67

If you think PDMS should create a tube between your components, and it doesn’t  you might wounder 
why…

To find out, you need to open up the[Show pipe component selection form]

General: Component Selection - Errors
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Component Selection form is brought up, hit the Errors page

And there you have it,  ELBOW 2 is CE and its Arrive 
bore at 50 dosn’t match the Leave Bore of the previous 
component

Switch CE ELBOW 1.
(the previous)

Same information, but from the another point of view
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Moving ELBOW 2 so it no longer is align with Elbow 1

[Refresh] at the bottom of the Component Selection form to update the Error information. 
Errors also updates by chaging CE

General: Component Selection – Errors cont.
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> q ldir 

> q adir

> q abore

> q lbore
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As mentioned in the beginning, there are new and old methods that can be 
used within PDMS to achieve your goals. Most of them work the same and 
everyone is happy.

But when talking to old school pipers using older methods, telling you how 
easy things are you need to be aware of on issue.

First, bring up the Piping Components window, used to create components.
Create > Components

1) Here you change Forwards or Backwards, just like Against Flow or With 
Flow

But. Changing from Forwards to Backwards does not effect selection of 
Against Flow or With Flow – so they work independently.

Forwards/Backwards VS With Flow/Against Flow
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New user use the Design Explorer to navigate the 
hierarchy and old school users can use other windows.

Display > Advanced Members

And we have the Members window up. Both display the 
same information.

1          
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Bring up all forms and windows at the same time.

1) Design Explorer,  2)Members, 3) Piping Components and 4) 
Component Creation

Keep an extra eye on the 5) CE dropdown lista on the ribbon.

Here’s an Elbow CE, next to a Tee.

Changing between With Flow and Against Flow with 4) only updates 
the aid graphic in the 3D view.

Now pick Backwards in 3) Piping Components
What happened?

Forwards/Backwards VS With Flow/Against Flow cont.
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No effect in Design Explorer, 1), ELBO 2 is still CE.

But, both  2) Members and 5) lists ELBO 1 as CE….??

Taking a closer look at 2) you’ll notice that the entire hierarchy has been 
inverted. GASK 2 who is last in flow for 1) is GASK 1 and first in flow in 2).

In 4) Component Creation form, [Connect] to create new Elbow.

It’s connected With Flow, which means the 4) form does not take into account 
the flow direction set by 3).

That’s it. 4) Design Explorer does not reorder the hierarchy and does not 
listen to changes from 3) Piping Creating or the Command Line

Forwards/Backwards VS With Flow/Against Flow cont.
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